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SCC-TC Series Thermocouple
Input Modules

The SCC-TC Series thermocouple input modules, SCC-TCO1 and
SCC-TCO02, accept input signals from B-, E-, J-, K-, N-, R-, S-, and T-type
thermocouples. Each module contains thermistor circuitry powered by
2.5V, to compensate for cold-junction effects and can detect open
thermocouple circuits. Each module has one thermocouple input channel,
which consists of a gain of 100 differential amplifier and a dual-pole 2 Hz
filter.

@ Note Alternatively, you can use the SCC-TCO02 as a 2 Hz lowpass bandwidth =100 mV
input module.

Conventions

The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

> @

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

When symbol is marked on a product, it denotes a warning advising you to
take precautions to avoid electrical shock.

When symbol is marked on a product, it denotes a component that may be
hot. Touching this component may result in bodily injury.

> >
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bold

italic

monospace

SC-2345

SCC

Bold text denotes items that you must select in the software, such as menu
items and dialog box options. Bold text also denotes parameter names.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

SC-2345 refers to both the SC-2345 connector block and the SC-2345
configurable connector.

SCC refers to any SCC series signal conditioning module.

What You Need to Get Started

To set up and use the SCC-TCOX, you need the following items:

U Hardware
- SCC-68
or
—  SC-2345/2350 with one of the following:
* SCC-PWRO1
e SCC-PWRO02 and the PSO1 power supply

*  SCC-PWRO03 (requires a 7 to 42 VDC power supply,
not included)

—  One or more SCC-0X

—  68-pin E/M Series DAQ device
—  68-pin cable

—  Quick Reference Label

U Software
—  The latest version of NI-DAQmx
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U Documentation
—  One of the following:
o SC-2345/2350 User Manual
*  SCC-68 User Guide
—  SCC-TC Series Thermocouple Input Modules User Guide
—  Read Me First: Safety and Radio-Frequency Interference
—  SCC Quick Start Guide

U Tools
— 1/8 in. flathead screwdriver
—  Numbers 1 and 2 Phillips screwdrivers

—  Wire insulation strippers

You can download needed documents from ni.com/manuals.

@ Note Software scaling of measurements is not supported on the Macintosh operating
system. Refer to the Scaling Voltage Measurements section for more information about
measurement scaling.

Device Specific Information

@ Note For general SCC module installation and signal connection information, and
information about the SC-2345 or SC-2350 carriers, refer to the SCC Quick Start Guide.

Installing the Module

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

You can plug the SCC-TCOX into any analog input socket on the SCC
carrier. The socket you select determines which E/M Series DAQ device
channels receive the SCC-TCOX signals.

For single-stage input conditioning, plug the SCC-TCO0X into any socket
J(X +1), where X is O to 7, and connect the input signals to the module as
described in the Connecting the Input Signals section.

If you use the SCC-TCOX in a dual-stage configuration, the SCC-TCOX
must be the first-stage module. Plug it into any socket J(X+9) and plug the
second-stage SCC into socket J(X+1), where X is O to 7. Connect the input
signals to SCC-TCOX as described in the Connecting the Input Signals
section. The SC-2345 connects the output signals of the first-stage SCC to

© National Instruments Corporation 3 SCC-TC Series Thermocouple Input Modules User Guide



the inputs of the second-stage SCC. An example of dual-stage conditioning
in an SCC-TCOX followed by an SCC-LPO1 lowpass filter module.

Sockets J9 to J16 also are available for digital input/output (DIO)
conditioning or control. Refer to the SC-2345/2350 User Manual for more
information on configuring, connecting, and installing SCC modules

@ Note SCC-TCOX dual-stage configuration is only available in NI-DAQmzx 7.1 or later.

Connecting the Input Signals

@ Note The signal names have changed. Refer to ni.com/info and enter rdtntg to
confirm the signal names.

The SCC-TCO1 has a two-prong uncompensated thermocouple
miniconnector that accepts any miniature or subminiature two-prong
male thermocouple connector. The SCC-TCO02 has a three-position
screw-terminal connector that accepts 28 to 16 AWG thermocouple wires.
The screw-terminal connector provides a ground connection for shielded
thermocouples. Otherwise, the two modules function identically.

To use an SCC-TCO1, plug the male thermocouple connector into the
module.

The SCC-TCO02 accepts up to three signals: TC+, TC—, and GND. TC+ is
the positive thermocouple lead and TC—is the negative thermocouple lead.!
The GND terminal connects to Al GND on the E/M Series DAQ device.

The SCC-TCOX has a 10 MQ bias resistor connected from the negative
thermocouple input to ground. This resistor allows the thermocouple to be
ground-referenced or floating without requiring external bias resistors
connected to ground.

The amplified thermocouple signal and cold-junction sensor signal
are measured by E/M Series DAQ device channel X and channel X+8
respectively, where X is O to 7 depending on where you plug the
SCC-TCOX. Refer to Figure 1 for SCC-TCOX signal connections.

! For ANSI color-coded J-type thermocouples, the red wire is negative and the white wire is positive. Refer to the thermocouple
data sheet if possible. You can find information about other color-coding schemes in the NI KnowledgeBase at ni . com/
support.
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E/M Series
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Figure 1. SCC-TCOX Signal Connections

For more information about how to configure the SCC-TC0X module using
NI-DAQmx, refer to the SCC Quick Start Guide.

Using the TCOX

Scaling Voltage Measurements

@ Note NI-DAQmx includes thermocouple and thermistor conversion utilities that
implement the conversions required in steps 3 and 5 of the following procedure. Refer to
your software documentation for more information on these utilities.

Your software environment may return only voltage measurements from
E/M Series DAQ devices. If so, you must convert voltage measurements to
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temperature measurements. To make this conversion, complete the
following steps:

1. Measure the thermocouple voltage.

a. Read the thermocouple channel on the E/M Series DAQ device

Viseries [CHX)].
b. Calculate the thermocouple voltage by using the following
formula:
V
V. = _ESERIES
re 100
where

Vrc is thermocouple voltage.
Veseries 18 E/M Series DAQ device voltage.

This step provides proper scaling for the thermocouple amplifier in the
SCC-TCOX.

2. Measure the reference-junction (cold-junction) temperature.
a. Read the thermistor voltage [AI (X+8)].

b. Convert the thermistor voltage to cold-junction temperature using
the formula in the Cold-Junction Sensor section.

3. Calculate the cold-junction compensation voltage by converting the
cold-junction temperature from step 2 to a thermocouple voltage. Use
the polynomial expressions applicable to the type of thermocouple you
are using.

4.  Apply the cold-junction compensation to the thermocouple reading
by adding the cold-junction compensation voltage from step 3 to V.

5. Calculate the thermocouple temperature by converting the voltage
result from step 4 to a temperature. Use the polynomial expressions
applicable to the type of thermocouple you are using. This calculation
gives you a linearized temperature measurement.

E Note Polynomials are from NIST Monograph 175.

Uncompensated Connectors and Accuracy

If you are using an SCC-TCO2 with an uncompensated SCC panelette,
temperature gradients between the module and the junctions on the
panelette affect the accuracy of the measurements.
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Detecting Open Thermocouples

The SCC-TCOX contains a 10 MQ pull-up resistor that connects to

+5 V to detect open thermocouples. To determine if you have an open
thermocouple, check whether the corresponding E/M Series DAQ device
channel is saturated. The pull-up and bias resistors saturate the channel by
applying +2.5 V at the input of an open channel. This results in saturation
to either the positive or negative rails of the EM Series DAQ device

(10 V).

Errors Due to Open-Thermocouple Detection Circuitry

The open-thermocouple detection circuitry can cause measurement errors.
These errors are the results of common-mode voltage at the input of the
SCC and current leakage into the signal leads. The 10 MQ bias resistor in
the SCC-TCOX causes this error to be negligible. With the 10 M(2 bias
resistor connected to ground and the 10 MQ pull-up resistor connected to
+5 VDC, a current leakage of approximately 0.25 pA (5 V/20 MQ) flows
into the unbroken floating thermocouple. Long thermocouple leads result
in larger voltage drops due to lead resistance.

For example, if you have a 24 AWG J-type thermocouple that is 20 ft long,
a voltage drop of approximately

4 pV =(0.145 Q/ft + 0.658 Q/ft) x 20 ft x 0.25 pA
can develop in the thermocouple, which corresponds to an error of 0.09 °C.

With 10 MQ pull-up and bias resistors, a common-mode voltage of

+2.5 VDC develops if the thermocouple is floating. The common-mode
rejection of the SCC-TCOX is sufficiently high, which results in the offset
voltage being negligible in most applications.

If your application demands extremely high accuracy, you can eliminate
these errors by calibrating the system. Refer to the Calibrating the
SCC-TCOX Using a Thermocouple Calibrator section for more
information.
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Cold-Junction Sensor

The cold-junction sensor voltage output varies from 1.91 to 0.58 V over a
0 to 55 °C temperature range.

@ Note NI-DAQmzx includes thermistor conversion utilities that implement the equations
listed below. Refer to your software documentation for more information on these utilities.

You can use the following formulas to convert the cold-junction sensor
voltage to cold-junction temperature:

T(°C) = Tx—-273.15
where Tk is the temperature in degrees kelvin.

1
[a+b(InR;) +c(InR;)’]

Ty =

where
a=1.295361 x 103
b=12343159 x 104
¢=1.018703 x 1077

Rris the resistance of the thermistor in ohms.

Vv
R = S,OOO( TEMPOUT )
r 2.5 ~Vrgmpour

where Vrempour is the output voltage of the cold-junction sensor.

T(°F) =

(79 , 5,
5

where T(°F) and T(°C) are the temperature readings in degrees Fahrenheit
and Celsius, respectively.

@ Note Vigypour varies from 1.91 V (at 0 °C) to 0.58 V (at 55 °C). For best resolution, use
the maximum gain for this range on the analog input channel.

For the cold-junction sensor measurement accuracy, refer to the
Specifications section.

For more information about how to configure the SCC-TCO0X using
NI-DAQmx, refer to the SCC Quick Start Guide.
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Calibrating System Offsets

To calibrate the offset voltage of the SCC-TCOX in the system using the
E/M Series DAQ device, complete the following steps. The E/M Series
DAQ device must be powered for 30 minutes before you calibrate the offset
voltage.

1. Select the desired channel and gain on the E/M Series DAQ device.

2. Short the inputs on the SCC-TCOX screw terminals or miniplug.

3. While acquiring data on the selected channel, use a screwdriver to
adjust the potentiometer protruding through the top of the module until
you read 0 VDC.

Calibrating the SCC-TC0X Using a Thermocouple
Calibrator

To calibrate the system using a thermocouple calibrator, complete the
following steps:

1. Make sure that the thermocouple connections at both the SCC and the
thermocouple calibrator are at the same temperature.

2. Connect the thermocouple calibrator to the SCC-TCOX. For best
results, use thermocouple wire of the same length and type that you
use in the thermocouple.

3. Set the thermocouple calibrator to the required calibration
temperature.

Measure the calibrator voltage using the SCC-TCO0X.

Convert the measured calibrator voltage to a temperature measurement
as described in the Scaling Voltage Measurements section.

6. Adjust the potentiometer on the top of the SCC-TCOX so that the
measured temperature is equal to the calibration temperature.
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Specifications

These specifications are typical at 25 °C unless otherwise stated.

Analog Input

Number of input channels..................... 1 DIFF

Input SignalS......cccceceevereevieneniienenieiene Thermocouples of types B, E, J,
K,N,R,S,and T

Input signal range ..........ccccceceevvervecneneene +100 mV

Input impedance .........cccoeeveererienenncnne 10 MQ powered on,

10 kQ powered off or overload
Bandwidth........ccocooiniiiiinniiiiie 2Hz

Amplifier Characteristics

Open thermocouple detection current.....250 nA max!
(assuming floating thermocouple)

Common-mode rejection ratio................ 110 dB min!

OULPUL TANEE ..o +10 V max!

Transfer Characteristics

GAIN .o 100

GAIN EITOT .. 10.08% max!

Gain stability......cccceevveeveiinieniiiieeeee, 40.0005%/°C max?

OffSEt  ITOT .....eeeieieeeeeeeeee e +5 uV max (post calibration)!
Offset Stability ........coovevevereeeiireeene. 0.6 uV/°C max?
NONHNEArity ........cccoeveveveveeererereerereverennne 1+0.004% max!
Recommended warm-up time................. 5 min

! Temperature range is 23 °C +5 °C.
2 Temperature range is 0 to 50 °C.
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Measurement Accuracy’

Thermocouple Temperature Maximum Typical
Type Range (°C) Inaccuracy (£°C) Inaccuracy (+°C)
B 400 to 600 2.5 0.31
600 to 1,800 2 0.13
E —200 to —100 2 1.76
—100 to 600 1 1
600 to 1,000 1.5 0.6
J —-200 to —100 2 1.6
—100 to 500 1 0.9
500 to 1,100 1.5 0.72
K —200 to —100 2.5 1.25
—-100 to 600 1.25 0.67
600 to 1,200 2 0.45
N —200 to —100 2.5 2
-100 to 1,300 2 0.7
R -50t0 0 3 1.24
0to 100 2 0.82
100 to1,600 1.75 04
S -50t0 0 3 1.3
0 to 1,400 2 1
1,400 to 1,600 2.5 1
T —200 to —100 2.5 2
—100 to 400 1 0.9

I' Total system measurement error for operating temperature within £5 °C of calibration temperature. Includes
PCI/AT-MIO-16XE-50 one-year accuracy specification of 0.01% +412 uV. SCC-TC01/02 accuracy specification of
0.08% £5 pV, and reference junction measurement accuracy of 0.5 °C. Assumes averaging. Non-averaged, single-point
reading has an additional uncertainty (up to 0.1 °C for J-type thermocouple).
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Cold-Junction Sensor

Cold-junction sensor accuracy................ 10.4 °C max from 15 to 35 °C,
10.75 °C max from 0 to 15 °C

and 35 to 55 °C

OULPUL . 1.91 V (0°C) to 0.58 V (55 °C)

@ Note The accuracy specification includes the combined effects of the temperature sensor
accuracy and the temperature difference between the temperature sensor and any
thermocouple connector. The temperature sensor accuracy includes component tolerances,
temperature drifts, and self-heating effects. It does not include measurement device errors.

Open Thermocouple Detection

Pull-up resistor........coeeveenervienenienienens 10 MQ
Bias reSiStor ......ooeeveereeienenieneeieieeens 10 MQ
Maximum field wire gauge.................... 16 AWG

Power Requirement

ANalog POWET .....eevueeriiinieeieiieenieeieene 60 mW max
FIS Vo 2 mA max
=I5V 2 mA max
Digital power (+5 V) c.oooevieviniiicncnnns 0.0 mW
Physical
1.87cm
, (074in) 7.60 cm

e —— N ———
: P (2.991in.) :

Figure 2. SCC-TCO1 Dimensions
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, (074in. b 7.93 cm o

< > < (3.12in.) >,
I T
L 3.55cm
-4 (1.41in.)

Figure 3. SCC-TC02 Dimensions

Weight
TC-01 e 25 g(0.9 0z)
TC-02 .o 22 g (0.8 0z)
Screw terminal wire gauge..................... 24t0 12 AWG
T/O e One 20-pin right angle male

connector, 3-pin screw
terminal system (SCC-TC02);
two-prong mini-connector
(SCC-TCO1)

Screw terminal field-wiring
gauge (SCC-TCO2) ..ccevveveeeenenienecnne. 28to 16 AWG

Maximum Working Voltage

Maximum working voltage refers to the signal voltage plus the
common-mode voltage.

Each input must remain within £12 V of chassis ground.

Measurement Category I
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Environmental

Operating temperature ..........cc.cceceevverneee 0to 50 °C

Storage temperature..............ccoeeeeruennnes —20to 70 °C

Humidity ....cccocevineniniicicicieecccceeee 10 to 90% RH, noncondensing
Maximum altitude...........oooovvvvveveiinnnnnnns 2,000 m

Pollution Degree (indoor use only) ........ 2

Safety

This product is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:

« IEC61010-1, EN-61010-1
« UL 61010-1, CAN/CSA-C22.2 No. 61010-1

@ Note For UL and other safety certifications, refer to the product label or visit ni . com/
certification, search by model number or product line, and click the appropriate link
in the Certification column.

Electromagnetic Compatibility

This product is designed to meet the requirements of the following
standards of EMC for electrical equipment for measurement, control,
and laboratory use:

* EN 61326 EMC requirements; Minimum Immunity
e EN 55011 Emissions; Group 1, Class A
e CE, C-Tick, ICES, and FCC Part 15 Emissions; Class A

Note For EMC compliance, operate this device according to product documentation.
In addition, all covers and filler panels must be installed.
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CE Compliance

This product meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:

*  73/23/EEC; Low-Voltage Directive (safety)
*  89/336/EEC; Electromagnetic Compatibility Directive (EMC)

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit ni . com/
certification, search by model number or product line, and click the appropriate link
in the Certification column.

Waste Electrical and Electronic Equipment (WEEE)
g EU Customers At the end of their life cycle, all products must be sent to a WEEE recycling

center. For more information about WEEE recycling centers and National Instruments
WEEE initiatives, visit ni.com/environment /weee.htm.

I/0 Connector Pin Assignments

Figure 4 shows the I/O connector pins on the bottom of the module.

0000000000
0.00000000 O O

1 Pin1 2 Pin2 3 PWB Key 4 Pin19 5 Pin20

Figure 4. SCC Module Bottom View
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Table 1 lists the signal connection corresponding to each pin. Al (X) and

Al (X+8) are the analog input signal channels of the E/M Series DAQ

device. AI GND is the analog input ground signal and is the reference for
Al (X) and AI (X+8). A GND is the reference for the £15 V supplies and

REF 5V. AI GND and A GND connect to the SC-2345/2350 at the
SCC-PWR connector.

Table 1. SCC Module Pin Signal Connections for SCC-TCOX Modules

Pin Number Signal
1 Al (X)
2 _

3 _

4 Al (X+8)
5 —

6 DAQ Device Al GND
7 _

8 _

9 _

10 —

11 A GND
12 REF5V
13 +15V
14 -15V
15 —

16 —

17 —

18 —

19 —
20 —

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section on ni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents . txt file on your CD, or
ni.com/patents.
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